
GEOG357: Remote sensing Lab 2  

Unsupervised classification 

General Goal: 

This lab involves identifying land cover types by using algorithms to group pixels with similar 

multi-spectral (ms) Digital Numbers (DN) / spectral signatures, separated by ms natural breaks. 

Open your copy of pg14sept2011.pix from last week, and display bands 5-4-3 in RGB 

1- Bitmaps  

Traditional analogue mapping from panchromatic aerial photography uses interpretation and 

manual digitising. We can simulate a digital process from one band ... this only works if a feature 

type has a unique set of DNs. Water reflects almost no NIR and thus has very low DNs in L5 TM 

Band 4 (L8 OLI Band 5). Extract water only - imagine you don't have a GIS layer for PG … 

Click around in the water and note the highest general DN for water in Band 4 (Near IR) – 

numbers are displayed in the green gun below the image - be sure not to catch any shoreline / 

mixed pixels. Note (and avoid) surface algae masses in Tabor Lake. 

You should also review the histogram for Band 4 to get an idea of the DN range for water. Check  

the ‘saddle’ low in the histogram to get an approximate idea of the DN value between water and 

land, and also the minimum DN value (15) – which will be water. 

zoom in a bit, maybe around the two rivers confluence (“T'enneh”). 

 We will use the DNs to try to identify ONLY water via the Threshold algorithm: 

 

Tools -> Algorithm Librarian -> click Find - and type THR  (then enter) 

 

It will find the algorithm and then click Open 

To reduce clutter, you might want to close the algorithm librarian window or move it away. 

Input: Tick channel 4 ....  the bottom panel should be checked on 'viewer' (screen only for now) 

click on the Input params tab, enter 0 for minimum and a conservative value for water as 

maximum - go low at first below your estimated value, e.g. 17 so it’s easier to 'up' it afterwards 

- click the Log tab and then Run (the screen shows the progress or errors) 

Some (but not all) water should fill with a default colour – likely red. 

Now up your maximum (Input params) to a value close to your estimated value and run again. 

The bitmap colour will likely be blue, makes it a bit challenging to discern from the image. 

Is all the water now filled ?   Up it again and repeat if it’s missing water areas.  



if some water areas are not coloured, highlight the bitmap layer on the left (in maps tab) and 

query the water DNs (Band 4).. possibly some water pixels are a bit higher; maybe you need to 

increase the maximum a bit more to cover these, but the bitmap may start to include shadows on 

the north side of the eskers north of the Nechako River in the Pidherny area. 

IMPORTANT POINT: when you read the DN values at bottom, they apply to whichever display 

layer you have active – it may not be the top one. Just as in GIS software, highlight the layer you 

are trying to query to be sure – here the 543 composite. If the active layer is the image, you see 

the 3 band DNs; if the bitmap above it is the layer, you will see 1 (water) or 0 (land) 

Eventually, you should find a value that hits just water and most of it – if you go too high, it 

starts to fill in non-water, but there is no perfect DN – either some water gets omitted or some 

non-water gets included.  Record what this value is. Right-click on the bitmap, select 

representation editor and it gives you # pixels that are water (1) and not (0).  

Zoom in on Shane Lake in Forest for the World – you will see the bitmap should have missed 

edge pixels which would have intermediate DN values between water and vegetation. 

Q1a. Which maximum DN did you use; 1b. What is the total area of water in km2. Convert from 

#pixels knowing that one pixel = 30x30m = 900m2. 

Once you have your best number value, Go back to the first tab (files) in THR 

check the box below viewer, hit browse and navigate to your copy of pg14sept2011.pix 

Run again, and this time it will add a bitmap (1 or 0) = water or land to your file. 

It is NOT overwriting your file, just adding a bitmap to it 

NEVER NEVER NEVER accept the useless default of ‘untitled.pix’ 

 

Check by switching from maps to files in the TOC (table of contents), and this should list a 

bitmap as well as the rasters; click on the + sign on the left to list your new bitmap. Change the 

bitmap description from ‘Contents not specified’ to Water: 

Right-click -> Properties .. click in Description box and type Water  … then click Apply and OK. 

Return to the Maps Tab. 

 

The .pix file contains all layers – it’s not like an Esri shapefile, more like a geodatabase (gdb). 

Compare the bitmap with the city rivers GIS layer: 

Layer-> Add-> Vector -> Next-> browse to L:\GEOG357\shapefiles\rivers.shp ->open-> 1(Vec)->finish 

 

Turn the bitmap on and off so you can see the vectors; they are not identical as the vectors were 

produced from higher resolution air photos, and may be more up to date than 2011. 

Much easier than manually digitising all the rivers and lakes.. !? - but maybe less accurate … 

Tidy up the display by right-clicking on each previous rejected bitmap and ‘remove from area’. 



2. Classification Introduction  
 
Classification involves identifying a set of unique spectral signatures (DNs) for a feature type in the 

image scene. We want our classifier to take advantage of maximum information content available in the 

image, so we will choose relatively uncorrelated bands to run the classification e.g. 5-4-3 and NOT 3-2-1   

BAND CORRELATION  
You should notice the following for Landsat TM data:  

1. VIS (visual) bands show cultural features and in detail 

2. NIR shows the land/water boundary sharply. Water appears black 

3. SWIR shows dryness or inverse of moisture (high DN = low moisture)  

4. TIR shows basic variations in temperature (though we won't use this) 

Ensure you are zoomed out to show the full extent – symbol to left of zoom options 

To view correlation between any selected band pair, Select layer -> scatterplot  

Look at the correlation between the following bands. The more correlated the bands, the closer 

the plotted points fall along a straight line (one band is nearly a linear function of the other).  

Green v Red     r = 0.95 

Green v NIR ? 

NIR v SWIR1     r = 0.71 

SWIR1 v SWIR2 (5 v 7) ? 

you should see a high 'r' between visible bands, and less with IR (except 5 v 7)  

r values correspond to the image data displayed – values will vary if you are zoomed in 

 

Q2a: what is the r value between the red and NIR bands ? (note it down – needed in answers) 

 

3. Unsupervised Classification algorithms 

 
You will now see the difference between a band (recorded by the sensor) and a channel – which 

can store a band, but also any other data generated by the user. We will add empty layers - 

8-bit channels which can store classification results each with up to 256 classes/clusters. 
 

You are ready to classify:  

• Analysis -> Image Classification -> Unsupervised 

• Select the file to use = your 2011 .pix file  

• Select New session 

• Click on add layer and add five (5) more 8-bit layers (channels)     ->add   ->close 

 

• We then need to specify the display, input bands and output CHANNEL 



• Select TM bands 5,4,3 (R, G, B) as input channels (and tick in input column)  

• The colour ticks in the first 3 columns are simply what is displayed 

• Select the first empty channel (8) as output * 

• NOTE *: the designated output channel will be overwritten, so if you specify a band 

number (1-7) you will LOSE the band data - always double check output channel number  

- it should be an empty or not-needed channel. -but it is recoverable if you lose a band. 

• click OK 

 

a. K-Means 
 

 In the Classify window, select these options:  

• Algorithm: K-Means  
• Max class: 6  
• Max Iteration: 6 
• Min Threshold: leave as is 
• Max Sample Size: leave as is (with a bigger scene, we might specify a subset)  
• Show Report button: 'on' (depressed) 
• OK 

..  this shows the report for the 6 clusters, # of pixels in each, and average DNs for bands 3,4,5  

..  image displays in 'PC' (pseudocolour), the new DNs are 1-6 (one number for each class). You 

can see which colour corresponds to which cluster number by querying some locations - you 

may need to highlight the new channel on left if the DN display at bottom is still on the RGB. 

This report could be saved if needed for future work (but is not needed here) 

Can you visually identify the clusters as classes approximately? (do a quick check) 

tick the PC (classification layer) off and on to view the classification then the 543 composite. 

View the report also - it gives the number of pixels in each class, and the mean DNs 

It should be poor as there are too few classes - and iterations 

Right-click the Classification MetaLayer and select run classification 

Set the number of classes (clusters) and iterations to 12 - view the result, its better, and view 

the classification report  – still some empty classes:  

Once more, Right-click the Classification MetaLayer and select run classification 

This time, try the default 16 classes/clusters and iterations then run classification again. This 

may seem better – click classification Metalayer off and on to compare with the image. Still 

some empty clusters, but we’ll keep it (in channel 8).  

Save the report file: use the save button and call it kmeans.txt 

Note the other options when you right-click the Metalayer e.g. accuracy assessment – we’ll use 

this in next week’s lab. 



One more trick using the water bitmap:  

Right-click Classification MetaLayer and select configure; change the output channel to 9.  OK 

Now run classification again. See the box below asking for a bitmap mask – of course, you have 

one – water. We can use that and thus tell the classifier “No need to waste clusters on water – we 

already did that for our bitmap ! 

Click on ‘use bitmap mask’ and select the water bitmap and select ‘outside bitmap’ = class the 

rest. In another case we might want to class only what is inside a bitmap mask e.g. water types 

here or fire severity inside a fire bitmap. 

Run …. and now it may occupy more clusters – saved in channel 9 ?   Water is class 0. 

Save the report- it will be a text file: use the save button and save to your geog357 folder with a  

suitable name e.g. kmeans2.txt 

As this layer will have a similar label to the previous classification, change its description under 

the Files tab e.g. K-means with water bitmap. 

Now you could match the cluster numbers with land cover types - click each colour to see which 

cluster it is, and try to visually match these against the list below. 

Change some colours for easier reading if you wish -  at the very least make the water cluster 

class blue, and coniferous forest dark green: expand ‘output’ checkmark and double-click on the 

legend colours to edit them.  [or right-click on classification metacolour – edit PCT  ] 

Note that some shadows get grouped with water – the north facing slopes of the esker ridges 

north of the Nechako River; next week we will see how this might be corrected.  

 

The classifiers are often challenged separating water from dark coniferous forest.  

 

Q3. Using either this image, or the 2013 image (below) -or both- which one of the three bands 

displayed shows the biggest difference between these two features and explain why this is so –  

– you can review the report or query some water and forest locations for their DN values. 

Cluster -> class identification 

Hopefully you can recognise some/most cluster classes from the underlying image and features. 

Some may be 'hybrid' or mixed, e.g. grassy areas could be regenerating cut areas, city parks, etc.. 

the bottom 3 clusters above chip piles may intermix. 

You can apply class names to the clusters: 

Right-click on the metalayer -> Representation editor and edit the cluster number to a name. Try 

a few – no need to do them all, though it’s quick and easy.    



See for example which cluster numbers correspond to: 

• Water  

• Conifers 

• Deciduous trees 

• Mixed forest 

• Industrial – urban 

• Residential - urban 

• Grass (e.g. soccer fields) 

• Agricultural fields 

• Cutblocks 

• Chip piles  

Any others ? e.g. mixed forest ? 

 

Simplified interpretation from the 5-4-3 display: 

•   Dark-green: coniferous. 

•   Light-green: deciduous. 

•   Pink: arable / agricultural. 

                                                         Yellow-green: Playing fields / golf courses 

•   Dark-purple: industrial. 

•   Light-purple: residential. 

•   Black: deep or sediment-free water. 

•   Blue: shallow or sediment-laden water. 

•             (White: bright: Canfor chip piles (brightest feature on this image) 

 

b. Fuzzy k-means 

Right-click Classification MetaLayer and again select configure; change output channel to 10 

Be sue to check fuzzy k-means for the alogithm 

Select default 16 / 16 in the clusters / iterations  - how does this compare with the K-means?  

If you need to re-display the previous k-means classification or any classification, select  

 layer->add->pseudocolour      select the k-means channel and finish 

 

 It’s tough to compare exactly as the colour palettes won’t match unless you make them do so - 

This one also mixes water and some shadows. Using water bitmap did not seem to help (I tried).  

Save the report:   fuzzy.txt 

 

Note that it ran slightly slower because the clustering process includes the spread of pixels in 

each cluster and probability functions, not just which seed point / mean each pixel is closest to. 

c. ISODATA classifier 



Right-click Classification MetaLayer and again select configure; change output channel to 11 

Now select Isodata as the algorithm. Use the 16 default options - Again view the result, and the 

classification report - almost all clusters should have a fair number of pixels and compare with 

the previous classification. Save the report – isodata.txt 

In order to display both or all 3 classifications, select from the layer dropdown as before: 

layer->add->pseudocolour-> next-> select your file and desired class channel -> finish 

– the software should have labelled them suitably. Click the fuzzy / isodata layers off /on to 

compare with the underlying colour composite … it may be hard to objectively tell, but for some 

the isodata slightly retains homogenous areas within the same class – not very scientific, but hey 

it's only a lab .. Review subjectively how well each sorts water from forest and coniferous from 

deciduous and mixed, as well as details in the bowl and residential versus industrial. The Isodata 

does seem to do better in the bowl, but to be sure we’d need to match the two colour palettes and 

perform an accuracy assessment (but not today – next week and maybe in your project …). 

One more  classification: we'll add bands 2 and 7 as extra input to see if they help: 

Metalayer -> Configure, add (tick input) bands 2 and 7 (so you’ll have 5 inputs)  - this is to show 

you are not limited to 3 input bands, but there are only 3 colour guns (RGB) for visual display 

– don’t change the RGB display (543) and now tick your last empty channel (12) for the output. 

Classify once more:       you can choose Isodata or one of the others if you prefer their result. 

Has it done any better than with only 3 input bands? … hard to tell – maybe not. Some research 

also suggests too many inputs can 'confuse' the algorithm to reduce class confidence. 

Edit the description for this channel so you know what it is e.g. isodata plus27 

 

4. Filtering / sieving the classification 

 
The classifications will always have isolated pixels, which are mostly undesirable 'noise'  

These can be reduced using the SIEVE algorithm 

In your 'favourite' classification, first note - what is the cluster number(s) for water .. this is so 

you can retain small lakes, as they may be meaningful.  

Tools -> Algorithm Librarian  

click the 'Find' button and type in sieve and then 'Open' [as you did with Threshold (THR)]. 

The parameters will be these: 

  input = ## (the channel number for your best classification )  



 output port should be viewer - PCT (at first)  

Let's do a small sieve – 1 acre which is ~ 4.5 pixels (1 acre is about 64x64m) 

 

 Input params: 

 Polygon size threshold= 5 (it must be an integer, not 4.5) 

 Connectedness - can be 4 or 8 (pixels can be joined vertically/horizontally or also by diagonals) 

 exclude values list = ##   (where ## is the class number for water)  

select log tab and run ...  

View the result, compared with the unsieved classification - click the sieve on and off and you 

should see the before and after;  

this may NOT be enough, so increase polygon size threshold to 11 (= 1 hectare), run. 

Which is better – 5 or 11 – save the one you prefer..  

- run it again, specify your filename under the 'files' tab in sieve, as output at the bottom - make 

sure you name your copy of pg14sept2011.pix. check the threshold is 5 or 11 (your choice) -run. 

This is now saved as a new channel in your file - check which one it is, by viewing your list of 

channels in the main tab on the left of the image, under 'Files' and expand the rasters list. It 

should be listed as a sieve. 

NOTE (again): NEVER accept the default filename 'Untitled.pix'. You must have all your data 

layers in the same file, and you should not EVER have a file named Untitled.pix in your folders 

the Sieve can look a bit like an art project, so we’ll also try the Modal filter as listed in lecture: 

Modal filter: find task FMO in the Algorithm librarian.  

Input = your classification channel, viewer = PCT;  

Input Params: choose a 3 x 3 filter size 

Switch to Log tab and Run 

How is this versus the Sieve ? Save it if you like it .. again as a new layer in your 2011 .pix file 

 
 

5. Prince George 2013 Landsat 8 OLI image 

 

The Landsat 8 Operational Land Imager (OLI) has 16-bit data … DNs can range from 0-65,535 

(but never do) Since 2015, both NASA Landsat and ESA Sentinel programs have 16 bit data. 

Maybe this extra precision might finally help separate the shadows from water ? 

 

We could add the newer image to this 'project' but it's less confusing to start a new project – you 

can save the other one if you like as a project e.g. lab2-pg2011.  



 

You could close this one and start a new project:  File-> New project  … but instead do this: 

 

You can have two Focus sessions running – click on the Focus (left) button on the 10 icon menu 

It will ask “are you sure you want to start this application”  YES .. you betcha ! (for comparison) 

 

Display (open) the 2013 image (copied last week) using the SWIR, Near IR, Red combination  – 

it has the extra band 1 (coastal blue), so the optimal combination is 654 instead of 543 for 

Landsat 5. Check the 654 histograms for 2013 and review the range of DNs for the NIR band 

 

FYI: How do you interpret the double minor modal peaks for low DNs in the NIR histogram ?   

(not present on the 2011 NIR band layer) – query some water values to see generally where these 

two modal values occur .. any thoughts ? 

 

a. Try some scatterplot combinations for this OLI 2013 image – they would be similar but not 

identical to the 2011 image: 

 

Q2b: What is the r value for Red versus Near-IR ? 

[Q3 repeat: Which band (3, 4 or 5) best differentiates between water and forest and why ? 

answer for either 2011 or 2013 –no need to answer twice, but viewing both might help] 

 

b. Bitmap – create the water bitmap same as you did for the 2011 image, of course you’ll need a 

very different threshold value and the range will be larger. 

 

Q4a. what is this approximate maximum DN value for water in the 2013 image ? 

b. what is the total area of water in km2 

 

Q5. Your answers for Q1b and 4b (water area 2011/2013) are likely not exactly equal: you 

should be able to think of 3 or more reasons why this is so – list them briefly -or if they are the 

same, why they could have been different ! 

 

 

c. Classification algorithms – no need to repeat everything – just do the one which you felt 

worked best – no prizes on this, it’s an intro lab. You’ll only need to create one new 8-bit 

channel for classification. Note: 8-bit even though the bands are 16-bit. Why? – because a 

classification should only need up to 256 values/classes, not thousands. 

  

Has the 16-bit image data helped better distinguish between water and the esker shadows ? 

 

Note the effect of the clouds and their shadows in the SW corner likely creating two extra 

classes– this shows why as much as possible we need ZERO clouds, not just low cloud cover… 

 

6. SIEVE / filter the classification – optional.   Only if you are having too much fun … 
 

 



Lab assignment 1 (5%) 
 

Assignment questions are designed to enhance your understanding of RS data, display and 

classification. Submit answers as plain text or word file via Moodle by Friday midnight - no need 

to include the questions, you can send in note form. Please include your name if in a word file. 

 

 

These questions were posed earlier in the lab; here they are summarised: 

 

Q1a. Which maximum DN did you use; 1b. What is the total area of water in km2. Convert from 

#pixels knowing that one pixel = 30x30m = 900m2. 

 

Q2. What is the correlation value (r) between Red and NIR for       a. 2011 and   b. 2023 

Q3: Which band (3, 4 or 5) best differentiates between water and forest and why ?  

 

 

Q4a.what is this approximate maximum DN value for water in the 2013 image ? 

b. what is the total area of water in km2 

 

 

Q5. Your answers for Q1b and 4b (water area) are likely not exactly the same: you should be 

able to think of 3 or more reasons why this is so – list them briefly -or if they are the same, why 

they could have been different … 

 
 

                               

 

Next week's lab: Supervised Classification 


